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SILICON SCULPTOR II LIMITED WARRANTY

The Silicon Sculptor II is manufactured by BP Microsystems, Inc. for Actel 
Corporation under an OEM agreement. There are two versions of the Silicon 
Sculptor; a single-site version, which will be referred to as the Silicon Sculptor 
II. Actel Corporation warrants the single-site Silicon Sculptor II product 
against defects in material or workmanship for a period of one year as follows:

For a period of three years for the now obsolete Silicon Sculptor I and one year 
for the current Silicon Sculptor II from date of purchase, Actel Corporation, 
through BP Microsystems, Inc., will repair or replace any defective product at no 
charge. Whether the warranted product should be repaired or replaced is wholly 
within the discretion of Actel Corporation and BP Microsystems, Inc.

This warranty does not cover any damage due to accident, misuse, abuse or 
negligence, nor does it cover normal wear items such as socket modules and 
filters.

You should retain your dated bill of sale as evidence of the date of purchase.

REPAIR OR REPLACEMENT AS PROVIDED UNDER THIS 
WARRANTY IS THE EXCLUSIVE REMEDY OF THE PURCHASER. IN 
NO EVENT SHALL ACTEL CORPORATION OR BP MICROSYSTEMS, 
INC. BE LIABLE FOR ANY SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, NOR FOR ANY DAMAGES 
RESULTING FROM USE, MISUSE OR MODIFICATION OF THIS 
PRODUCT. EXCEPT TO THE EXTENT PROHIBITED BY 
APPLICABLE LAW, ANY IMPLIED WARRANTY OR 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE IS 
SPECIFICALLY DISCLAIMED. UNDER NO CIRCUMSTANCES SHALL 
TOTAL LIABILITY for ACTEL CORPORATION OR BP 
MICROSYSTEMS, INC. EXCEED THE PURCHASE PRICE OF THE 
PRODUCT.

This warranty gives you specific legal rights, and you may also have other rights 
that vary from state to state.
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Introduction

Thank you for selecting the Silicon Sculptor Programming System. This user's guide is designed to 
help you take full advantage of the Silicon Sculptor's capabilities. The bulk of this manual is 
intended for Silicon Sculptor II series programmers, but may be used for Silicon Sculptor I series 
programmers and Silicon Sculptor 6X programmers, as the software is identical. The main practical 
restriction is that no more than two Silicon Sculptor II series programmers can be chained together 
for concurrent programming, and a standard IEEE 1284 parallel cable (EPP) must be used for this 
purpose. The optional multi-headed extender cable can only be used on Silicon Sculptor I series 
programmers; it is not to be used on Silicon Sculptor II series programmers.

Document Organization
The Silicon Sculptor II User’s Guide is divided into the following chapters:

Chapter 1 - Getting Started is a quick reference for beginning use of a programmer through the 
ActelWin software.

Chapter 2 - Command Reference is organized by function and command, listing details and usage. 

Chapter 3 - Troubleshooting covers error messages that are not self-explanatory and helps you 
identify problems.

Appendix A - Product Support provides information about contacting Actel for customer technical 
support.

Appendix B - Glossary defines some useful terms that appear in this manual. 

Document Assumptions
The information in this guide is based on the following assumptions:

1. You are familiar with PCs and are running Windows 95/98/2000, Windows XP, or Windows 
NT 4.0 or later.

2. You are familiar with Actel FPGA architecture and Actel FPGA design software.

Document Conventions
This manual uses the following conventions:

Information input by the user follows this format:

keyboard input
Actel Silicon Sculptor II Windows® Environments User’s Guide 7



Introduction
The contents of a file follows this format:

file contents

Messages displayed on the screen appear as follows:

screen message

Actel Manuals
Actel’s Designer Series software includes printed and online manuals. The online manuals are in 
PDF format on the Designer CD-ROM and the Libero CD-ROM in the “\Designer\docs” folder 
in the Designer and the Libero software directory. These manuals are also installed onto your a 
system when you install the Designer software. To view the online manuals, you must install Adobe 

Acrobat Reader from the CD-ROM. For the most up-to-date documentation, go to the Actel 
website (www.actel.com). 

Online Help
The Designer Series software comes with online help. Online help specific to each software tool is 
available in Designer, ACTgen, Silicon Explorer, and Silicon Sculptor. Online help is also available 
within the Libero IDE software and Synplicity Synplify® software.
8 Actel Silicon Sculptor II Windows® Environments User’s Guide
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1
Getting Started

This chapter describes how to install and test the software. It also contains important operating 
information that is useful when programming chips. For more detailed information about each 
command listed in this chapter, see “Command Reference” on page 27.

Compatibility
Silicon Sculptor II is designed to operate with any PC with the following minimum system 

requirements:

• Windows NT 4.0 with SP5 or SP6 

• Windows 2000 with SP1 or SP2 or SP3 or SP4 

• Windows XP with SP1

• Pentium 133 or higher (Pentium 200 or higher recommended) processor 

• 64 MB of available memory for use 

• 50 MB of available hard disk space · VGA or higher-resolution video adapter (SVGA 256-color 
and 800x600 or higher resolution recommended) 

• Parallel printer port (LPT1, LPT2, or LPT3)

• CD-ROM disk drive, and a hard drive.

Note: For NT 4.0 and Windows 2000 systems, you must have administration rights to the local 
workstation for installation purposes. For NT 4.0, Windows 2000, and Windows XP systems, 
you must have administration rights to the local workstation for installation purposes.

The Silicon Sculptor II has nonvolatile memory. More specifically, it has Flash memory 

(29F200TB) on a board that stores the BIOS and varies small EEPROMs. It also has SIMM 
modules that store the programming data (such as afm/bit stream). The programming data is never 
stored in the nonvolatile memory.

Hardware Installation
After you unpack the equipment, you are ready to connect the Silicon Sculptor II to your PC. 

To connect the Silicon Sculptor II to your PC:

1. Connect the programmer to a parallel printer port on your PC. Connect one end of the cable to 
the programmer’s connector and tighten the screws. Plug the other end of the cable into your 
parallel printer port. 
Actel Silicon Sculptor II Windows® Environments User’s Guide 9



Getting Started
2. Verify that you have connected to the correct parallel port on your computer. Actel recommends 
that you dedicate a port to the programmer. Connecting to a serial port or third party card can 
damage the programmer. This type of damage is not covered by the warranty. 

3. Power up the programmer. Plug the programmer AC power cord into a power socket. 

Note: The Silicon Sculptor II power supply operates from 90 to 250 VAC for simplified 
worldwide use.

4. Turn on the computer and programmer. Both the green Power LED and the yellow Active LED 
on the programmer site will light up. Silicon Sculptor II is performing a Power On Self-test 
when the Active LED is on. After a minute or two, the yellow Active LED will turn off and only 
the green Power LED will remain on. If the Fail LED turns on, the Silicon Sculptor II has 
detected an error during the Power On Self-test. If this occurs, call Actel’s technical support line. 
See “Contacting the Customer Technical Support Center” on page 60 for a complete list of 
technical support options.
10 Actel Silicon Sculptor II Windows® Environments User’s Guide



Software Installation
Software Installation
Your software installation procedure depends on whether you downloaded the software from the 
internet or are installing from a CD-ROM. Follow the instructions below to install the Silicon 
Sculptor software on your computer. 

To install the software from the Internet download:

Go to http://www.actel.com/custsup/updates/silisculpt/ and download the latest Windows version 
of Sculptor programming software.

When prompted, choose the drive and directory the self-extracting .EXE file will be saved in. Once 
the download is complete, double-click the .EXE file to install the software.

To install the software from CD-ROM:

1. Insert the Silicon Sculptor CD. If the CD start-up browser screen does not start automatically 
when you insert the Silicon Sculptor CD, go to Start > Run, then type the following command 
in the Open box:

d:\setup.exe
The “d” in the above command represents the drive letter of your CD-ROM. If your CD-ROM 
has a different drive designation, substitute the letter that designates your CD-ROM drive.

2. Select a location for the SculptW program files. Once activated, the installation screen for the 
software opens. The installation prompts you to choose a folder name and location for the 
SculptW program files. The installation software provides a default location. To place these files 
in an alternate location, click in the field provided and type the location address. 

If you have a previous version of the software installed on your computer, the installation 
procedure prompts you to uninstall the older version before continuing the new installation 
procedures.

3. Run Silicon Sculptor. Go to Start > Programs > Silicon Sculptor. 

Silicon Sculptor Basics
SculptW utilizes all the standard functions of windows-based applications, including pull-down 
menus, action buttons, and hot keys, along with online help files. See “Command Reference” on 
page 27 for more information on these functions.
Actel Silicon Sculptor II Windows® Environments User’s Guide 11
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Getting Started
The initial screen of the SculptW software divides into two sections. The uppermost section is the 
main program window. It contains the software title and version number, as well as the pull-down 
menus and the tracking system for the devices you are about to program (Figure 1-1). 

Figure 1-1. SculptW Main Screen

Use the secondary, floating window (known as the Action/Function window) to designate devices 
and data patterns and start and stop programming actions (see “Command Reference” on page 27 
for a more information on these functions). The title bar of the Action/Function window displays 
the following information:

• Programmer detected or selected. In the example shown in Figure 1-2 on page 13, the selected 
programmer is Silicon Sculptor II.

• The technology adapter and socket module detected by SculptW. In the example shown in 
Figure 1-2 on page 13, the technology adapter and socket module is SM208PQBACT. 

• The location of the parallel port that detects the programmer. In the example shown in 
Figure 1-2 on page 13, the parallel port is LPT1. 

Note: If the software does not detect a programmer, it automatically starts in DEMO mode, and
12 Actel Silicon Sculptor II Windows® Environments User’s Guide



Silicon Sculptor Basics
all actions/functions are available in the DEMO mode except programming a device. You 
can add a programmer after startup in DEMO mode by going to File > Configure. 

Figure 1-2. SculptW Detects Silicon Sculptor

The bottom pull-down menu, visible only when the program window is fully expanded, keeps a 
running list of all the actions you performed and the device(s) you select during active use of the 
software. Once you exit the software, the tracking list is reset.

Selecting a Chip
Click the Device button in the Action/Function window to select a chip. The Device button opens 
the Select Device dialog box. The list of parts in the Select Device dialog box contains every device 

Programmer Programming
Module

Parallel
Port
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Getting Started
currently supported by Silicon Sculptor II (Figure 1-3). Choose a device by scrolling down the 
available list, or use the search engine by typing directly into the Look for text field. 

Figure 1-3. Select Device Window

The search engine associates characters typed in the Look for field with the characters that are found 
in one or more string items listed in the software’s device inventory. These characters do not have to 
be the beginning of the string line (i.e. the manufacturer’s name).
14 Actel Silicon Sculptor II Windows® Environments User’s Guide



Silicon Sculptor Basics
If you type the letters “s” and “x,” the software narrows the list down to any parts listed with those 
two letters in that particular order, shortest name first. As you type, the list becomes more refined 
until you select a particular device. See Figure 1-4.

Figure 1-4. SculptW Search Engine

To narrow your choices before you search, select a Package Type and/or Architecture from the pull-
down menus. Any package type or architecture not matching the type selected in the pull-down 
menu is excluded from the search. See “Command Reference” on page 27 for more information on 
the device selector. 

Loading a Data Pattern Programming File
To load a data pattern programming file:

(The AFM file format is for Antifuse Families and the STAPL/BIT file formats are for Flash 
Families)

1. Open the Data Pattern window. Click the Data Pattern button in the Action/Function 
window. See Figure 1-5.
Actel Silicon Sculptor II Windows® Environments User’s Guide 15



Figure 1-5. Data Pattern Dialog Box

2. Load File into Buffer. Click the Open button and click the Browse button and 
select a programming file. Confirm the file information and click OK to 
continue. See Figure 1-6.

Figure 1-6. Load File Into Buffer Dialog Box



Silicon Sculptor Basics
The software automatically identifies the file type and displays the information in a the 
Buffer Load Option section of the dialog box for verification. See Figure 1-7. Once you 
confirm the file information, click OK. The file will load into the data buffer. (A 
confirmation window will be displayed to prompt to clear buffers. Click OK to clear 
buffer).

Figure 1-7. Load File Into Buffer Dialog Box 

After the file is loaded, click the Cancel button to exit.
Actel Silicon Sculptor II Windows® Environments User’s Guide 17



Getting Started
Data Pattern Information
This section provides a description of the displayed information for the data pattern.

Antifuse Devices

When you load the buffer, information regarding the loaded AFM file is displayed next to 
the Data Pattern Button as shown in Figure 1-8.

Figure 1-8. AFM File Information in the Data Pattern

Fuse Checksum (Four Digit HEX Number)

This is read directly off from the fuse checksum line in the AFM file: 

|VAR FUSCHECKSUM XXXX

Note: XXXX is a 4 digit HEX number.

Changing this manually will have no effect on the other two checksums, but problems will 
occur when you try to verify the part later after programming.

The fuse checksum is programmed into all Actel antifuse devices at the end of the 
programming sequence. This information can be used to match a programmed device to 
its programming (AFM) file. The fuse checksum is calculated from the fuses in the AFM 
18 Actel Silicon Sculptor II Windows® Environments User’s Guide



Silicon Sculptor Basics
file. This number will be unique for each fuse map. This number can also change if the 
target die is changed, even though no change has been made to the layout of the device.

Note: You must not modify any contents of the AFM file to avoid the integrity and 
contents of the AFM file from corruption.

File CHECKSUM (Eight Digit HEX Number)

In the AFM file, there is also a commented line in the header, which is the File Checksum 
of the AFM file:

CHECKSUM XXXXXXXX

Note: XXXXXXXX is a 8 digit HEX number.

During loading, the software looks at the contents of the file that are not commented, 
computes a file checksum, and compares it to this. If this does not match, an error will 
occur as shown below:

checksum comparison failed...read checksum is 416EC623...computed checksum is 
4a56a41f.

CSUM

CSUM is calculated with a combination of the device you select and the data in the buffer 
(which contains the programming file contents). A different CSUM number means a 
different setup is configured, which is a combination of device you select and the 
programming file. To verify programming the data programmed to the device with the 
programming file, use the Fuse Checksum value.

Placing a Chip in the Socket
Refer to the appropriate device programmer manual to place a device in the socket 
module. 

Note: Parts must not be inserted or removed when the ACTIVE LED is on.
Actel Silicon Sculptor II Windows® Environments User’s Guide 19



Getting Started
Programming a Device
After you select a target device and load a data pattern (programming file), you can 
program the device by selecting the appropriate actions in the tab windows. See Table 1-1 
for action tab descriptions. 

You can perform the Blank and Secure actions individually or you can perform these 
actions during the programming sequence. 

Blank Check Action
You can perform the Blank Check action to check the state of the device.

To perform the Blank Check action:

1. Select the Blank tab.

2. Click Execute.

Secure Action
You can perform the Secure action to program only the security fuse of the device after you 
have previously programmed a device.

To perform the Secure action:

1. Select the Secure tab.

2. Click Execute

Table 1-1. Action Descriptions

Action Tab Description

Program

The Program tab executes all actions including 
Blank Check, Program, and Secure in one 
step. You can also do the Actel Checksum 
action in this tab.

Blank
The Blank tab performs the Blank Check 
action to check the state of the device.

Secure
The Secure tab performs the Secure action to 
program only the security fuse of the device.
20 Actel Silicon Sculptor II Windows® Environments User’s Guide



Silicon Sculptor Basics
Program Action
Follow the steps below to program a device.

To program a device:

1. Select Program from the tab window.

2. Check the “Blank Check Action”checkbox in the Program tab (Recommended).

3. Select Program from the second pull down menu. See Figure 1-9.

4. If desired, check the “Secure Action” textbox in the Program tab to program the 
security fuse.

5. Click Exectue.

Figure 1-9. Programming Dialog Box

After you programmed the device, verify that the device is programmed successfully by 
performing the Actel Checksum action. 

To perform the Checksum action:

1. Uncheck the Blank Check option in the Program tab if checked.

2. Select Actel_ChkSum in the second pull-down menu (see Figure 1-9).
Actel Silicon Sculptor II Windows® Environments User’s Guide 21
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3. Uncheck the Secure option if checked.

4. Click Execute.

Note: The software displays a message in the log window with the correct fuse checksum 
that matches the AFM file's FUSCHECKSUM.

Concurrent Programming
Silicon Sculptor II is a concurrent programmer, multiple sites can simultaneously program 
the same design. Your PC is used to hold the data that will be programmed into the 
devices. Specific programming algorithms and instructions are stored on the PC and 
downloaded to the programmer when you select a chip and load the buffer. Thus, the 
algorithm is actually executed by each programmer's internal microprocessor. This 
guarantees accurate wave forms and precisely controlled critical time delays, independent 
of the PC's performance. The speed of your PC will only affect the rate at which the 
programming algorithm and data is downloaded to the programmer and will not affect 
programming yield.

Two is the maximum number of Silicon Sculptor II units that you can connect for 
concurrent programming.  The two Silicon Sculptor IIs must be joined together via a 
standard IEEE 1284 parallel cable (The special extension cable for use with the Silicon 
Sculptor I's may not be used with Silicon Sculptor II's).

The Individual System Diagnostic Self-Test section explains how to setup two Silicon 
Sculptor IIs to facilitate concurrent programming. 

Note: This section assumes that you have installed the Sculptor programming software. If 
you have not installed it, download the latest version from the Actel Website.

Individual System Diagnostic Self-Test
Before attempting concurrent setup, you should connect each Silicon Sculptor II 
individually and run them through a full system diagnostic self-test. One parameter to pay 
special attention to is the BIOS version number. Sculptors will only operate concurrently 
if the BIOS version is the same on each one. You can find the BIOS version number in the 
Diagnostic test result summary, as shown in Figure 1-10.
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Concurrent Programming
Figure 1-10. Diagnostic Test Result Summary
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Getting Started
Please refer to section“Testing the Hardware” on page 47 for diagnostic test procedures.

Concurrent Setup
The concurrent setup is very straight forward, follow the instructions below.

To perform concurrent setup:

1. Make sure the Sculptors are powered OFF. 

2. Connect power cords to each Sculptor and plug them in. 

3. Connect the first Sculptor to the parallel port of the PC. 

Note: Do not use any print buffers or electronic switches on the same port as the 
programmer.

4. Connect the second Sculptor to the first Sculptor in a daisy chain configuration using 
the custom expansion cable as shown in Figure 1-11.

Figure 1-11. Concurrent Setup

5. Power on both Sculptors. 

6. Invoke the Sculptor Windows software.

7. Once communication has been established, perform a system Diagnostic self-test. 

This system self-test looks very similar to the individual self-test, except that two units are 
detected. This is apparent in the second screen of the self-test as shown in Figure 1-12 
below.
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Concurrent Programming
Figure 1-12. Screen of Self-Test Dialog Box

Executing Concurrent Operation
Once all systems have passed the self-test, you are ready to insert the correct adaptor 
modules and begin programming devices. Follow the same procedures as described in 
“Programming a Device” on page 20.

For Silicon Sculptor I concurrent programming, please refer to the following document:  
http://www.actel.com/apps/guru/sep98/hw1675.html.
Actel Silicon Sculptor II Windows® Environments User’s Guide 25
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2
Command Reference

The Actel Silicon Sculptor software places standard, device-specific functions at your command. 
Commands are located in drop down menus and file tabs in the main screen as well as hot-link 
buttons on each active dialog box. To execute a command, select the appropriate button or option. 

Pull-Down Menus
The following section describes the pull-down menus available in Actel Silicon Sculptor software. 

File
Use the commands under the File menu to control the communication with the programmer, input 
special code to enable advanced features, and monitor the number of copies you want to make. In 
addition, use the commands under the File menu to reset the program settings to their defaults and 
modify certain global options. 

Configure

Configure re-establishes communication with the programmer. This allows you to change 
programmers if necessary. It also opens a dialog box that lists several options. This dialog box 
enables you to switch the handler type from manual to auto-handler status, and to specify an 
experience level (Novice or Experienced). 

Figure 2-1. Configure Dialog Box for Actel Silicon Sculptor

The following menus are available in the Command dialog box in Silicon Sculptor: 

• LPT Port identifies which parallel port is connected to the programmer. Choose from DEMO, 
LPT1, LPT2, or LPT3. Selecting DEMO disables communications with the programmer. You 
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can utilize any of the software's functions while in DEMO mode, but you cannot program a 
device. 

Note: DEMO is the default selection if Sculptor cannot detect a programmer.

• Programmer Model identifies which model programmer you are using. Select any programmer in 
DEMO mode and view the list of devices supported on that particular model in the Device Select 
dialog box. 

• Master Site indicates the Silicon Sculptor programmer that is connected to the PC. 

• User Mode distinguishes between Experienced and Novice modes. Experienced mode permits 
options not allowed in Novice mode. For example, clearing the buffer and displaying ICC 
measurements on Verify and Test is available only in Experienced mode.

Selecting Novice instructs the program to prompt you to accept or cancel before you perform each 
operation. Novice is the default setting.

Upgrade

The Upgrade dialog box (Figure 2-2) allows you to input a special code, which enables Advanced 
Features (AFS) in the software. This code is required in order to enable the Actel Silicon Sculptor 
program to continue communications with the device programmer and to get support for all Actel 
devices. For more information, see “Troubleshooting” on page 47. 

Figure 2-2. Upgrade Dialog Box

To receive an upgrade code, contact Actel Technical Support. See “Product Support” on page 59 for 
a complete list of technical support contact information. 
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Tools
Use the commands in the Tools menu to reset the Silicon Sculptor configuration. 

Programmer Diagnostic

Programmer Diagnostic runs the programmer diagnostic test, also called self test (Figure 2-3). The 
Silicon Sculptor diagnostics ensure that the power supplies function properly and test the integrity 
of all the pin drivers. Select Actel Diagnostic from the Device tab. 

Figure 2-3. Diagnostics Dialog Box
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Click OK to run the test on the CPU, RAM, ROM, logic communication, power supplies, 
motherboard analog, pin driver boards, current regulators, and mother board. The Diagnostics 
Report dialog box (Figure 2-4) opens when the tests are complete. 

Figure 2-4. Diagnostics Report Dialog Box

Default Configure

Default Configure (Figure 2-5 on page 31) enables you to reset all the settings to the default 
configuration. When this option is selected, you are asked to confirm whether or not you want to 
reset to the default configuration. This option is available to allow you to reset any given command 
back to its original settings whether or not you have changed the command.
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For example, if a device calls for a mandatory verify and the operator changes it to Verify Twice, the 
Default Configure option will allow the user to change the setting back to a single verify. 

Figure 2-5. Default Configure Dialog Box

Options

The Options dialog box enables you to set global options. 

Figure 2-6. User Options Dialog Box

• Error Beep turns on or off the sounds used to indicate completion, errors, end of job, etc.

• Elapsed Time displays the duration of time of a specific operation, i.e. Read, Program, etc.

Copies

The Copies field enables you to enter the number of devices you want to program. The software 
automatically tracks how many you have finished, how many failed, and how many remain to be 
programmed. When Sculptor reaches the Copies Number successfully, it displays a Job Summary 
report for printing. 
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Help

Help/Tech Support lists the phone numbers and e-mail address for reaching Actel Technical 
Support. You can also refer to “Product Support” on page 59 for technical support contact 
information. 

Help/About Actel Silicon Sculptor displays the current Silicon Sculptor version number and 
software specifics. 

Action Buttons
Actel Silicon Sculptor includes action button links (commonly known as “buttons”) as well as pull-
down menus and file tabs that enable you to direct the program to specific locations and tasks. The 
following is a list of the action buttons and their functions.

Device Button
The Device button enables you to access to the list of devices supported by the designated device 
programmer via the Select Device dialog box.

Select Device Dialog Box

The Select Device dialog box (Figure 2-7) offers a list of devices supported on the programmer 
model selected in Configure or detected by the software. Select a device to configure the 
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programmer with the correct programming algorithm. The algorithm is specified by Actel and 
contains the voltage, timing, and pin-out requirements. 

Figure 2-7. Select Device Dialog Box

Type the part number in the Look for text box. Notice that as you type the characters the device list 
narrows to show only those devices containing the characters you have typed, in the order you type 
them. To further narrow the list, designate a particular package type or architecture.

Click the desired selection from the list of supported devices. It is important to select the correct 
device for programming. Some character suffixes at the end of the part number pertain to 
temperature or speed ratings and are not of importance for programming. Choose the device that 
most closely matches your device part number.

When you have highlighted the correct device and entered the appropriate information, click the 
Select button to load the algorithm for that device or Cancel to escape without selecting. 

The Package Type dialog box narrows the search by listing only devices with the package type you 
select. 

The Architecture dialog box narrows the search by listing only devices with the type of architecture 
you select.

Note: Changing the Package Type and Architecture fields can cause the changed options to revert 
to the default settings. 
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Dev Info Button

The Dev Info button lists information for the highlighted device including certain notes and 
relevant precautions (Figure 2-8). The notes and precautions include algorithm settings, incorrect 
data pattern information, erasing procedures, etc.

Figure 2-8. Device Information Dialog Box

Once you select a device and the Select Device window closes, the device information appears in the 
field next to the Device button. A note or warning may appear in the Device Information window 
to inform you of any additional relevant information.

Data Pattern Button
Once you make a device selection, you must choose a data pattern. Click the Data Pattern button to 
display the Data Pattern dialog box (Figure 2-9). Use this dialog box to load data into the buffer 
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from a file or another device. Browse to your file and load as necessary. The Data Pattern dialog box 
enables you to select a data pattern, clear the buffer, or edit the buffer.

Figure 2-9. Data Pattern Dialog Box

Check Sum displays two fields with pull-down menus. You can select an 8- or 16-bit sum method. 
Device sums the number of bytes in the buffer equal to the byte count in the device you selected. If 
you load a file that is smaller than the device you selected, Silicon Sculptor uses the Default Buffer 
Value when summing the remaining bytes.
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Open Button

The Open button brings up the Load File into Buffer window. Several options are available before 
loading the file. Actel’s Antifuse devices use the AFM file formats, while Flash devices use STAPL 
or BIT file formats. 

Figure 2-10. Load File Into Buffer Dialog Box

The Load File As pull-down menu allows you to specify the file type of the data you wish to load. 
Even though the software interrogates the file and automatically chooses the file type, it is important 
that you select the correct file type so that the correct data is loaded at the correct address. If the file 
type you select is not consistent with the type you wish to load, use the pull-down menu option to 
choose the appropriate type.

When you load the AFM file from the Load File Into Buffer dialog box, the programming software 
automatically disables the following options: 

• Load entire file (checked as default)

• Clear buffer before loading (checked as default) 

• Automatic lowest address to load

• Lowest address from file to load

• Highest address from file to load

• Address in buffer to place data
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Decimal or Hexadecimal enables you to select a preference for viewing address information in any 
preceding fields. 

Once you have determined your specs and are ready to load the file into the buffer, click OK. If you 
wish to exit without loading the buffer, click Cancel.

Summary: To load the buffer from a file, select the drive, directory, folder, and file. Select the file 
you wish to load, and then click the Open button. The Load File into Buffer window appears and 
prompts you to designate the file type. After you designate the data type for the file, the data is 
loaded into the buffer.

Save Button

The Save button brings up the Save File from Buffer dialog box and saves the buffer contents to 
disk. You can choose any local or network drive available when you save the file. 

Figure 2-11. Save File from Buffer Dialog Box

• File Name text field is where you type the name of the data file. Actel recommends that you adhere 
to the standard 8/3 format (eight-character name followed by three-character extension for file 
type).

• Save file as field allows you to designate the file type when formatting the data file.

• Save entire buffer contents is checked by default. Uncheck this box if you wish to save a specific 
address range. When unchecked, the Lowest buffer address to save and the Highest buffer address 
to save options become available.

• Lowest buffer address to save field allows you to specify the lowest buffer address to save.

• Highest buffer address to save field allows you to specify the highest buffer address to save.

• Decimal or Hexadecimal enables you to select a preference for viewing address information in any 
preceding fields.

To save the file, click OK. To exit without saving, click Cancel.
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Close Button

The Close button closes the Data Pattern dialog box without opening a file. If you save a file or 
make any checksum selections, these changes are saved over the original file and are active when you 
retrieve the file later.

Edit Button

Click the Edit button to edit the buffer contents. 

Figure 2-12. Buffer Editor Dialog Box

The Buffer Editor dialog box lists the addresses on the left of the screen, the data for each address in 
the middle with the fuse legend directly above, and the ASCII version of the file on the right.

The Buffer Editor window enables you to: 

• Goto a certain memory location within the buffer 

• Fill a range of addresses with a certain value 

• Copy a specified memory range to another location within the buffer 

• Search for a data pattern within the buffer 

• Specify Dec or Hex via a button 

The Search function enables you to start your search from a particular address (in the Start Address 
field) or search for a particular pattern of data (in the Pattern field). The Pattern field enables you to 
specify whether the pattern you are searching for is in hex or ASCII and whether the search goes 
forward or backward from the starting address.
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Note: Actel recommends that you do not edit the programming file to avoid corruption. 

Clear Button

The Clear button clears the buffer contents to the value specified as the default buffer value. This 
button only appears when the Configure menu option is set to Experienced Mode.

Options Button

The Options button enables you to set options specific to the data buffer. The default buffer value is 
0x00. This option will fill the address locations not specified in the file to 0x00 or 0xFF, whichever is 
selected. 

Figure 2-13. Buffer Options Dialog Box

Device Config Button
The Device Config button can only be found in Demo mode. 

Job Master Mode
If you want to use the Job Master mode, notify BP Microsystems.

Main Screen File Tabs
Depending on the device you select, any of the following action/function file tabs can appear in your 
viewing screen.

Actel_ChkSum
Calculates, displays, and verifies the Actel design checksum for single-site operation. Verifies the 
design checksum of the program file to the checksum value programmed into the device. Also 
displays the 16-bit (4-hex) checksum and the 20-bit (5-hex) user-defined design ID.
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Blank
Verifies that a device is blank (all fuses unprogrammed, or open). Prior to programming, verifies that 
a device has not been previously programmed. This operation is automatically executed prior to 
programming any device.

Program
Programs a device from data in the buffer. The Program button programs your design into the 
device. It also verifies that the correct device type is inserted into the socket and verifies the device is 
blank (unprogrammed) before programming begins.

Secure
Programs the Security fuse(s) to prevent unwanted probing of the device. You can program Security 
fuses on an Actel device that has had its Array fuses previously programmed. The ability to program 
Security fuses after programming Array fuses is designed to allow you to debug your device design 
with the Silicon Explorer diagnostic tool. After you debug your design, you can program the 
Security fuses to secure the device from further probing.

ACT 1 or 40MX Security Fuse Configurations

The ACT 1 or 40MX devices contain two security fuses: Probe and Program. Programming the 
Probe fuse disables the Probe Circuitry, which disables the use of the Debugger, ActionProbe, and 
Silicon Explorer diagnostic tools. Programming the Program fuse prevents further programming of 
the device, including programming the Probe fuse. Table 2-2 summarizes the effects of 
programming the Security fuses on the PRA, PRB, SDI, and DCLK pins. In the normal operating 
mode (MODE=0), all undefined device pins in a design are automatically configured as active LOW 
outputs. Two exceptions are the SDI and DCLK pins. If the Program fuse is not programmed and 
SDI and DCLK are undefined, they are configured as inactive inputs. In this case, SDI and DCLK 
pins should be tied to ground. If the Program fuse is programmed and SDI and DCLK are 
undefined, they will become active LOW outputs. 

Table 2-2. Security Fuse Configurations- ACT1 or 40 MX Devices

Modea Program Probe PRA, PRB SDI, DCLK

Low No (deselect) No User-defined I/O
User-defined Input 
Onlyb

Low No Yesc User-defined I/O
User-defined Input 
Onlyb
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Low Yesd No User-defined I/O User-defined I/O

Low Yesd Yesc User-defined I/O User-defined I/O

High No No
Actionprobe 
Outputse Actionprobe Inputsf

High No Yesc Actionprobe 
Disabled 

Actionprobe 
Disabled 

High Yesd No
Actionprobe 
Outputse Actionprobe Inputsf

High Yesd Yesc Actionprobe 
Disabled 

Actionprobe 
Disabled 

a. The MODE pin switches the device between the normal operating mode
(MODE=0) and the Probe Circuit mode (MODE=1).

b. The Program fuse must be programmed if the SDI or DCLK pins are to be used as
an output or a bidirectional pin.

c. If the Probe fuse is programmed, the Probe Circuit is permanently disabled, which
disables the Silicon Explorer diagnostic tool. 

d. If the Program fuse is programmed, all programming of the device is disabled,
including programming the array fuses and the Probe fuse. 

Table 2-2. Security Fuse Configurations- ACT1 or 40 MX Devices (Continued)

Modea Program Probe PRA, PRB SDI, DCLK
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e. The PRA output and a separate I/O buffer share the use of a single device pin. The
PRA output and the output function of the I/O buffer are multiplexed. The same is
true for PRB. The Probe Mode that is loaded into the Mode Register determines
which output buffer is active during probing. There are three possible Probe Modes:
“PRA only,” “PRB only,” and “PRA and PRB.”

When you select the “PRA only” mode, the PRA output becomes active and the
output function of the I/O buffer associated with the PRA pin is inhibited. However,
the input buffer portion of the I/O buffer associated with the PRA pin is still active.
Any internal signal that appears on the PRA output is fed back through that input
buffer to the internal Logic Modules. This could interfere with the expected function
of the design during probing. Actel recommends that you use an input latch on PRA
and PRB to prevent the feedback while probing. PRB functions as a normal I/O in the
“PRA only” mode. 

The “PRB only” mode is functionally equivalent to the “PRA only” mode. PRA also
functions as a normal user I/O in the “PRB only” mode. 

When you select the “PRA and PRB” mode, both the PRA and PRB outputs become
active and the output function of the I/O buffers associated with both pins are
inhibited. However, the input buffer of the I/O buffers associated with both pins are
still active. Any internal signals that appear on the PRA and PRB outputs are fed back
through the input buffers to the internal Logic Modules. This could interfere with the
expected function of the design while probing. Actel recommends that you use an
input latch on PRA and PRB to prevent the feedback during probing. 

f. The SDI input and a separate I/O buffer share the use of a single device pin. The
SDI input and the input function of the I/O buffer are connected in parallel. When
the Mode pin is high, both inputs are active. The same is true for DCLK. External
Probe Circuit control signals sent to those pins are also sent to the internal Logic
Modules. This could interfere with the expected function of the design while probing.
Actel recommends that you use an input latch on SDI and DCLK to prevent the
external Probe Circuit control signals from effecting the functionality of your design
during probing. If either SDI or DCLK are configured so that the output function of
the I/O buffer is active, the Program fuse must be programmed. In this configuration,
the signals from your design are fed back to the Shift Register and will interfere with
the function of the Probe Circuitry. In addition, the I/O drivers will conflict the
external SDI and DCLK drivers. Damage to both drivers could occur. 
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Non-ACT 1 or 40MX Security Fuse Configurations

All Actel devices other than ACT 1 or 40MX devices contain one Security fuse. Programming the 
Security fuse disables the Probe Circuitry, which disables the use of the ActionProbe and Silicon 
Explorer diagnostic tools. Table 2-3 summarizes the effect or programming the security fuse on the 
PRA, PRB, SDI, and DCLK pins. 

In the normal operating mode (MODE=0), all undefined device pins in a design are automatically 
configured as active LOW outputs. You do not need to program the Security fuse to enable SDI and 
DCLK as active LOW outputs.

Table 2-3. Security Fuse Configurations- Non-ACT1 or 40MX Devices

Modea

a. The MODE pin switches the device between the normal operating mode
(MODE=0) and the Probe Circuit mode (MODE=1). 

Security PRA, PRB SDI, DCLK

Low – User-defined I/O User-defined I/O

High No Actionprobe Outputsb

b. Please refer to Table 2-2 on page 40, item e. 

Actionprobe Inputsc

c. The SDI input and a separate I/O buffer share the use of a single device pin. The
SDI input and the input function of the I/O buffer are connected in parallel. When
the Mode pin is high, both inputs are active. The same is true for DCLK. External
Probe Circuit control signals sent to those pins are also sent to the internal Logic
Modules. This could interfere with the expected function of the design while
probing. Actel recommends that you use an input latch on SDI and DCLK to
prevent the external Probe Circuit control signals from effecting the functionality
of your design during probing. An input latch is an integral part of the I/O buffers
in the non-ACT 1 devices. The output function of the I/O buffers associated with
SDI and DCLK do not interfere with the function of the Probe Circuitry while in
the Probe Mode. When the Mode pin is driven high, these outputs are inhibited.
The I/O drivers do not interfere with the external drivers. However, these outputs
are not observable in the Probe Mode.

High Yesd

d. If the Security fuse is programmed, the Probe Circuit is permanently disabled,
which in turn disables the ActionProbe and the Silicon Explorer diagnostic tools. 

Actionprobe Inputs Actionprobe Inputs
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Keyboard Usage and Hot-Keys
Actel Silicon Sculptor utilizes keystroke combinations, called hot-keys or quick keys, to allow you 
more freedom in invoking the program functions. Listed below are common keys and keystroke 
combinations used within the software. You can also use the keystroke combination ALT + 
[underlined character] wherever applicable.

For example, press ALT+F to open the File menu instead of using your mouse. 

Table 2-4. Common Usage Keys

KEY FUNCTION

Esc
Close the current window/retain original information. 
*Does not work in Configure window, must actually click on 
the Cancel button.

<-, ->, Move left or right to a selection.

Up arrow, 
down arrow

Move up or down to a selection.

Enter Execute function command that is selected.

Table 2-5. Common Hot-Keys

KEY COMBINATION FUNCTION

ALT-C
Opens Device Configure window (available only 
in Demo mode)

ALT-D Opens Select Device window

ALT-E Execute or Test, depending on device selected

ALT-F Opens the File menu

ALT-H Opens the Help menu

ALT-O
Used only in Data Pattern window; selects the 
Open button
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ALT-P Selects the Program file tab

ALT-S
Selects Secure file tab or Stop button if Secure 
tab is not available.

ALT-T Selects Tools drop down menu.

ALT-V Selects Verify file tab.

Table 2-6. Dialog Box Command Functions

KEY FUNCTION

Esc Cancel the active window and return to Main Screen.

Enter Exit the dialog box and execute command.

Home Move to first selection of current line.

End Move to last selection of current line.

Table 2-7. Edit Command Functions

KEY FUNCTION

Up arrow, down arrow, left arrow, 
right arrow

Move cursor.

Home Move to front of current line.

End Move to end of current line.

CTRL-U Upgrade window.

Enter Make selection.

Table 2-5. Common Hot-Keys (Continued)

KEY COMBINATION FUNCTION
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Troubleshooting

The information in this chapter can help you solve or identify a problem with your software and/or 
programmer. If you have a problem that you cannot solve, please contact Actel Technical Support. 
Actel is dedicated to making its software and programmers as trouble-free as possible.

Tech Support 
You can get technical support from Actel whenever you experience a problem that you cannot solve. 
Refer to “Product Support” on page 59 for contact information. Please have the following 
information ready when you contact technical support: 

• The model number of the Actel programmer (title bar of secondary screen)

• The software version number (from the top of the main screen)

• The exact error message and error number received

• The exact algorithm that was selected

• The exact part number on the chip you were trying to program

• The command executed

• The results of running the self-test command on your programmer (BP Microsystems 
Diagnostics).

It is also useful to have a screen print of the error. You may be asked to send your programming file 
(PLEASE ZIP BEFORE SENDING) and/or send in your devices so we can analyze the error at 
the factory.

If you need to return your programmer to Actel for any reason, you must call and get a Return 
Material Authorization (RMA) number before shipping. Mark the RMA number clearly on the 
shipping container. Be sure to include a description of the problem experienced, a return address, 
contact person, and contact phone number.

Testing the Hardware
The programmer can test its hardware quite extensively. The self-test routine can detect problems in 
the pin-drivers, power supply, microprocessor, data cable, printer port, and several other circuits. 

The hardware test cannot detect problems resulting from a dirty socket.

Note: Remove any chips from the programmer site(s) before you proceed. 
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The SculptWin software enables you to test all applicable parts within the device programmer for 
accuracy. This test helps to ensure that the programmer is running at performance standards.

Figure 3-1. SculptW Dialog Box with Test Information

To begin running the self-test on your device programmer, click the Device button and select Actel 
Diagnostics from the list of available devices, or type diagnostics. Once selected, the main window 
displays the Actel Diagnostics label in the Device field and a Test file tab appears (Figure 3-1). 
To begin testing the programmer, click the Test button. The Test dialog box opens, as shown in 
Figure 3-2. 

Figure 3-2. Test Dialog Box
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The Test dialog box verifies how many units you want to test. After you click OK to begin the test, 
a window appears to prompt you to ensure that there is no chip in the socket (Figure 3-3). 

Figure 3-3. Diagnostics Info for Self Test Window

The test begins and runs until it is done or until you click on the Stop button. If you decide to cancel 
the self-test, click the Stop button at any time during the procedure. A window appears to 
acknowledge the operation was aborted (Figure 3-4). To re-execute the test, simply click the Test 
button again. 

Figure 3-4. Self-Test Abort Window

Your programmer should pass the test. Verify by checking the green PASS LED on the chassis of the 
programmer. If your programmer does not pass the test, the red FAIL LED activates and an error 
message will appear on the screen: 

Error 47: Self-test failed. This unit may need service. Please call 
technical support.

If this should happen, double-check the fidelity of the cable connections and try again. Note the 
exact error message and call for technical assistance if the message persists (see “Actel Technical 
Support” on page 59 for contact information.).

Software Updates
The control software for your programmer is updated on a frequent basis (typically every two 
months) to add features and provide you with support for new chips. Software updates can be 
obtained from Actel (see “Customer Service” on page 59 for contact information, or visit the Actel 
website at www.actel.com). Depending on the type of programmer you have (engineer, production, 
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or automated), upgrades and renewals may need to be made by contacting the Actel sales 
department.

If you decline the software/hardware upgrade and your software support runs out, the following 
message will appear when you select a part:

Error Code 57: Device Not Enabled

Your programmer is designed to be highly flexible and programmable, allowing it to program a wide 
variety of chips. Consequently, when a problem does arise, it can usually be fixed with a software 
update.

Actel recommends that you obtain the latest software revision before calling the support line with a 
software problem. The solution for many of technical support calls is the latest version of the 
software. 

FAQs
The questions below represent a list of the most commonly asked questions from callers. It does not 
represent a complete list. Please visit the Actel website for more information. 

What is the proper way to handle the programming file for electronic 
transfer?

Actel strongly recommends that you always ZIP the programming files before performing any file 
transfers electronically. This will ensure that the integrity and contents of the programming file are 
intact and will avoid file corruption during transfer.

The Silicon Sculptor II does not communicate with computers installed 
with Windows 2000/WinXP, and the GUI is fixed in Demo Mode. What 
is the communication problem and why is the GUI fixed in the Demo 
Mode?

Silicon Sculptor IIs are based on the BP x600 technology. These programmers are faster than other 
programmers from BP partly because they use EPP, communication on the LPT1 port. The Silicon 
Sculptor I communicates using bi-directional, ECP, or EPP. You must set the Silicon Sculptor II to 
EPP; otherwise, it does not communicate on most computers and the GUI is fixed in Demo Mode. 

You need to go into the BIOS setup, find the LPT1 port settings, and change the LPT1 Port Mode 
to EPP.

However, there may be cases where the Silicon Sculptor II will still fail to communicate with 
computers installed with Windows 2000 operating systems, no matter which parallel port setting is 
set.
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In this case, if the Sculptor II still cannot communicate with the computer, the parallel port cable 
may be the cause of the problem. Silicon Sculptor IIs must use IEEE 1284 compliant parallel port 
cables. Please make sure the parallel port cable is IEEE 1284 compliant.

Why does the SculptW NT 4.0 software keep failing?

The device drivers are not installed or are not being recognized by the software. The Actel software 
that runs on an NT environment is attempting to establish communication with the device 
programmer through the drivers. When the drivers are not found, it fails the software. To remedy 
this, install or re-install the device drivers for the software. Refer to the steps following the next 
question to obtain the device drivers and verify that the software is recognizing them.

Why isn't SculptW running in the NT environment?

The Windows NT 4.0 system requires the installation of a system device driver. The first step to is 
to find out whether a device driver is installed.

1. Open the control panel. Go to Start > Settings > Control Panel. 

2. Open Devices. Double-click the Devices icon. 

3. Select the device BPNTDriver. Verify that the device driver status is set to started and startup 
is set to automatic. If these selections are not designated for the device driver, click to select the 
driver. To set the status to start, click the Start button. NT attempts to start the device driver 
when you click the Start button. To set the driver startup to automatic, click the Startup button 
and select Automatic. 

If for some reason the device driver does not install or you need to uninstall the driver, go to the 
command prompt. Go to the NTDrvr directory in the default installation directory. For example, 
the default installation directory for Silicon Sculptor is C:\siliconwin. 

• To uninstall from this directory type: 

drvinstl -u

• To install from this directory type: 

drvinstl -i

There are registry settings for the device driver and as soon as there is a full definition they will be 
added here.

In the DOS version, the configuration settings were saved to a file. 
Where did they go?

With the introduction of the Actel windows software, the configuration settings are no longer saved 
to a file. These settings are now being saved in the Windows 95/98/NT 4.0 registry and are not 
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deleted when they are uninstalled. This allows you to continue to use previous settings when 
upgrading to a new version of the software. There may be cases however, when you are required to 
delete these settings. To do so, execute the following steps: 

1. Run regedit. Go to Start > Run and type regedit. 

2. Select ActelWin. Select ActelWin from the VB and VBA Program Settings file list. 

3. Delete the ActelWin registry settings. The ActelWin registry settings have now been deleted. 
The new registry settings appear in this directory upon re-installation or upgrade of the software.

Errors While Programming
If you experience problems while trying to program a chip, try to narrow down the problem. If you 
receive a Cannot program or Cannot erase error messages while programming: 

• Make sure you have selected the proper device (i.e. the device programming algorithm). 

• The device may have been previously secured; use Blank Check to verify whether or not the device 
is blank. (See the topic “Blank” on page 40 for more information.)

• The device may have a newer die than the one supported by the device (i.e. the device 
programming algorithm).

Cleaning a Dirty DIP Socket
If the DIP socket becomes dirty, it sometimes fails to make contact with all the chip pins. The 
simple fix is to place your chip in the socket, push the lever down, and slide the chip left and right a 
few times.   Actel also recommends cleaning sockets with a blast of high-pressure air on a regular 
basis.

If this does not resolve the problem, run the hardware self-test described above. If your hardware 
passes the self-test, there may be an error in the programming algorithm you are using or Actel may 
have updated the programming algorithm for your device. In either event, your can probably correct 
your problem with a software update.

Error Messages and Suggested Actions
Error messages are usually generated by the device programmer. When you receive an error message, 
refer to the appropriate device programmer manual's troubleshooting section. The following is a list 
of error messages that could originate from the software.
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Version Mismatch - BPEng.dll and BPAlg.db versions mismatched

The engine and algorithm database versions do not match. Accepting this error message prompts an 
exit from the software. Contact technical support for further assistance. Refer to “Actel Technical 
Support” on page 59 for contact information.

BPPgmr.ocx - BPPgmr.ocx internal error

SculptW generates this error when the unique coding sequence attached to both the BPPgmr.ocx 
and the BPEng.dll do not match. Accepting this error message prompts an exit from the software. 
Contact technical support for further assistance. Refer to “Actel Technical Support” on page 59 for 
contact information.

Algo Database Error - Error loading BPAlg.db

This is a “catch all” error code. SculptW generates this error if anything not listed above causes an 
error while loading the algorithm database. Accepting this error message prompts an exit from the 
software. Contact technical support for further assistance. Refer to “Actel Technical Support” on 
page 59 for contact information.

BPNtloDll - No parallel port is available

ActelWin NT 4.0 generates an error if the device drivers are not installed. The software attempts to 
establish communication with the programmer through the driver. When the driver is not found, it 
fails the software. In order to remedy this, you must install the device drivers for the software. Please 
refer to “FAQs” on page 50 for procedures.

Error 3: Cannot reset hardware

The software cannot establish communication with the programmer:

• Be sure the programmer has power and that the green PASS LED is on. Since the programmer 
performs an automatic Power On Self Test (POST) on startup, it could be that the programmer 
failed the test and has signaled the software into the default DEMO mode. If this should happen, 
contact technical support for further assistance. See “Actel Technical Support” on page 59 for 
contact information.

• Make sure the cable from the programmer to the computer is properly connected to a parallel 
printer port. If you are using a ribbon cable, this is probably the problem (ribbon cable connectors 
are designed for use inside a chassis where the cable is not flexed). You should use a shielded 25-
pin standard IEEE 1284 compliant cable, not an RS-232 cable.

• Check your LPT port. If you have multiple parallel ports, you may have the ports configured 
incorrectly, with two at the same address. 

• Some laptops have the ability to disable the port. If you are working on a laptop, make sure the 
LPT port is enabled.
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• Another program (such as a print cache) may be interfering with the port. When running under 
Windows, you increase the likelihood of another program trying to access the same parallel port 
and changing the expected status at the port.

• If you have a hardware lock key between the programmer and the port, try removing it.

• The programmer may be damaged. Try using a different computer and/or parallel port and see if 
it works. 

Error 5: Hardware time-out

The software issues this error message when it is waiting on a response from the programmer while 
executing a command and the programmer does not respond within the expected amount of time. 
This error can result from several causes. You may be experiencing communication errors (see “Error 
3: Cannot reset hardware” on page 53). There may be a bug in the software for this particular 
algorithm (see “Error 10: Error in programming algorithm. Please call technical support.” on page 
54). Refer to “Testing the Hardware” on page 47 for more information. 

Error 6: Wrong model number

See “Error 3: Cannot reset hardware” on page 53 for possible causes. 

Error 8: LPTx: is not a functioning port

The parallel port LPTx (where x=1, 2 or 3) that is selected with the Configure command does not 
exist on your computer, is not functional, or has a bad cable connected to it.

Error 9: Programmer execution error

The programmer failed an internal consistency check. See “Error 3: Cannot reset hardware” on page 
53 and “Error 5: Hardware time-out” for possible causes.

Error 10: Error in programming algorithm. Please call technical 
support.

The software has detected an internal error. You should contact Actel to report the error. You may 
need to upgrade your system with the most recent release of the software posted on the Actel 
website. See “Actel Technical Support” on page 59 for contact information. 

Error 11: There is no data in the buffer. You must load a file or read a 
chip.

A command tried to read data from the buffer to program or verify a chip, but nothing has been 
loaded into the buffer yet or the buffer was recently cleared.
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Error 14: There is no chip in the programmer site

Be certain that you inserted your chip correctly. If it was inserted correctly, remove it and run the 
hardware self-test to be sure your programmer is functioning correctly using Actel Diagnostics (see 
“Testing the Hardware” on page 47). 

A defective chip may also cause this error. When using an autohandler, the contactor may not have 
closed or the connection between the programmer and the contactor may be disconnected.

Error 15: The chip is not inserted in the programmer site correctly

The continuity test determined that the chip in the programmer site does not have continuity on all 
the proper pins. You should examine these pins carefully. Possible causes are:

• A bent pin

• The chip is not in the proper position in the programmer site. 

• The chip has a different number of pins than the chip selected.

• The algorithm selected has a *, indicating that it requires an adapter but you did not use the 
adapter, or vice-versa.

• The socket is dirty and not making a connection. See “Cleaning a Dirty DIP Socket” on page 52 
for more information.

• The wrong socket module or adapter is being used for this part.

• The device may be a very low power device that is not properly detected by Actel’s continuity 
methodology. If so, please let us know.

Note: It's not easy to get continuity on an LCC device in a PLCC socket. If you are trying to do so, 
you may need to add a spacer between the chip and the lid in order to apply the proper force 
to the device pins. The best solution is to purchase an LCC socket module that does not 
require any such modification. Also, LCC devices do not work at all in the autoeject sockets 
designed strictly for PLCC devices.

Error 16: The chip is inserted backwards

The chip has passed the continuity tests, but appears to have the GND and Vcc pins improperly 
placed in the socket. If LCC, PLCC, or QFP is not accidentally rotated, then the device is probably 
defective. Try a known good device.

Error 17: Out of base memory. You should have at least 200K free.

Your computer's configuration does not have enough RAM available to run the software. You should 
have 640K RAM installed with at least 200K available for program execution. Memory resident 
programs, such as network drivers, can reduce the RAM available to the programmer, so you may 
need to remove these programs from your CONFIG.SYS and AUTOEXEC.BAT files.
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Error 18: Temporary file error

The software's virtual memory manager is trying to store data that is currently not needed in RAM 
to the disk. The program was unable to create a temporary file, or the disk is full. Make sure you 
have plenty of disk space (the larger the data files, the larger the requirement for temporary disk 
space). The program does take advantage of EMS memory if you have an expanded memory 
manager installed. This is much faster than using the disk for temporary swap space.

Error 21: Cannot program

Not able to program the device in the programmer site. See “Errors While Programming” on page 
52 for more information.

Error 23: Invalid electronic signature in chip (device ID)

• The chip may be damaged or the programming algorithm may have changed.

• The orientation of the device may be misorientated. Make sure the device is inserted properly.

Error 24: Invalid electronic signature in chip (algorithm ID)

The chip may be damaged or the programming algorithm may have changed. 

Error 26: Device is not blank

The Device/Blank command was executed or the Blank check before programming option was 
enabled in the Device/Options dialog box, and the device in the programmer site is determined to 
have programmed data. You may have used the wrong algorithm, or the device may have been 
programmed previously. 

Error 27: Device is not secured

An attempt to secure a device was made, but it failed. See “Errors While Programming” on page 52 
for more information.

Error 31: Database file is invalid. The .EXE file is corrupted.

The .EXE file you are executing has been corrupted. You should uninstall and then reinstall the 
software to fix the executable. See “Actel Technical Support” on page 59 for contact information.

Error 32: Sorry, algorithm not found. Please call technical support.

The .EXE file you are executing has been corrupted. You should get a new copy from Actel. See 
“Actel Technical Support” on page 59 for contact information.
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Error 33: You must reselect the chip you want to program.

The device was selected before establishing communication with the programmer; this may have 
been done prior to turning on the programmer or before switching to a different programmer. 
Reselect the chip and the error should not re-occur. 

Error 36: You must properly install the correct socket module.

You will get this error message if:

• No socket module is installed.

• The socket module installed does not support the device you have selected.

• The socket module installed is not supported by the version of the software you are using. Use the 
latest version.

• The pinout has not yet been defined for this package type. Verify that the other possible causes 
have been eliminated. If so, this may be an oversight on Actel’s part. In a case of persistent error, 
please contact technical support with the data. See “Actel Technical Support” on page 59 for 
contact information.

Error 39: Device already secured

The device cannot be legitimately programmed, read, etc., because it is secured. If it is a PLD, it may 
still be functionally tested with the Test command under the Test tab (see “Testing the Hardware” 
on page 47). 

Error 44: Internal error. Please call technical support.

The software detected an internal inconsistency. This may be caused by the computer not 
performing correctly. Contact technical support. See “Actel Technical Support” on page 59 for 
contact information.

Error 46: AFS software required to execute this function

This is a function that is available to users who have purchased the Advanced Feature Software only. 
In order to use the chosen function you must purchase the AFS upgrade. 

Error 47: Self-test failed. This unit may need service. Please call 
technical support.

The self-test (Actel Diagnostics) has detected a hardware problem. The unit may need to be 
returned for repair. Note the exact error message and contact Technical Support. See “Actel 
Technical Support” on page 59 for contact information.
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Error 57: You must purchase support for this device to use it.

The device that you selected is not supported in the default device set for this programmer. Call 
Actel Sales to purchase an upgrade code for your programmer (see “Product Support” on page 59 for 
contact information).

Error 70: The buffer data cannot be used to program this device.

You loaded a file type that is not a valid option for the currently selected device. Re-select the device 
and load the buffer again. If the error persists, call technical support. See “Actel Technical Support” 
on page 59 for technical support contact information. 



A
Product Support

Actel backs its products with various support services including Customer Service, a Customer 
Technical Support Center, a web site, an FTP site, electronic mail, and worldwide sales offices. 
This appendix contains information about contacting Actel and using these support services.

Customer Service
Contact Customer Service for non-technical product support, such as product pricing, product 
upgrades, update information, order status, and authorization.

From Northeast and North Central U.S.A., call 650.318.4480
From Southeast and Southwest U.S.A., call 650. 318.4480
From South Central U.S.A., call 650.318.4434
From Northwest U.S.A., call 650.318.4434
From Canada, call 650.318.4480
From Europe, call 650.318.4252 or +44 (0)1276.401500
From Japan, call 650.318.4743
From the rest of the world, call 650.318.4743
Fax, from anywhere in the world 650. 318.8044

Actel Customer Technical Support Center
Actel staffs its Customer Technical Support Center with highly skilled engineers who can help 
answer your hardware, software, and design questions. The Customer Technical Support 
Center spends a great deal of time creating application notes and answers to FAQs. So, before 
you contact us, please visit our online resources. It is very likely we have already answered your 
questions.

Actel Technical Support
Visit the Actel Customer Support website (www.actel.com/custsup/search.html) for more 
information and support. Many answers available on the searchable web resource include 
diagrams, illustrations, and links to other resources on the Actel web site. 

Website
You can browse a variety of technical and non-technical information on Actel’s home page, at 
www.actel.com. 
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Contacting the Customer Technical Support Center Email
Contacting the Customer Technical Support Center
Highly skilled engineers staff the Technical Support Center from 7:00 A.M. to 6:00 P.M., Pacific 
Time, Monday through Friday. Several ways of contacting the center follow:

Email You can communicate your technical questions to our email address and receive answers back by 
email, fax, or phone. Also, if you have design problems, you can email your design files to receive 
assistance. We constantly monitor the email account throughout the day. When sending your 
request to us, please be sure to include a detailed description of the problem you are experiencing, 
your full name, company name, and your contact information for efficient processing of your request.

The technical support email address is tech@actel.com.

Phone Our Technical Support Center answers all calls. The center retrieves information, such as your 
name, company name, phone number and your question, and then issues a case number. The Center 
then forwards the information to a queue where the first available application engineer receives the 
data and returns your call. The phone hours are from 7:00 A.M. to 6:00 P.M., Pacific Time, Monday 
through Friday. The Technical Support numbers are:

650.318.4460
800.262.1060

Customers needing assistance outside the US time zones can either contact technical support via 
email (tech@actel.com) or contact a local sales office. Sales office listings can be found at 
www.actel.com/contact/offices/index.html.
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Glossary

BGA Ball Grid Array. A surface mount device with solder balls and a high 
pin count, similar to PGA.

blank check A test performed by a device programmer to ascertain whether a 
device has been programmed (partial or total) or is in a virgin state.

checksum A number that results by adding up every element of a pattern. 
Typically either a four or eight digit hex number, it is a quick way to 
identify a pattern, since it is very unlikely that two patterns will have 
the same checksum.

compare Reading a programmable device and displaying any discrepancies 
from the desired pattern. Each error is displayed on the screen. This 
comparison is slower to perform than a verify on the programmer.

concurrent programmer A multiple-socket programmer that starts programming each device 
as soon as it is inserted in a socket, without all sockets having to be 
filled.

device Microchip or Integrated Circuit chip.

dialog box The method used by the device programmer’s user-interface 
software to allow the user to select options and specify information. 
The user can specify any options and fill any blanks in the box then 
press ENTER to force the software to process the information.

die The silicon chip that is located within an IC package. It is a small 
rectangular flat piece of silicon that has been fabricated with many 
transistors to perform a specific function. It is glued into a plastic or 
ceramic package and connected to the external metal interconnect 
pins of the IC with very small bonding wires. 

FPGA Field Programmable Gate Array. A very complex PLD. The FPGA 
usually has an architecture that comprises a large number of simple 
logic blocks, a number of input/output pads, and a method to make 
random connections between the elements.

gang programmer A multiple-socket programmer that requires each device to be placed 
in a socket before any can be programmed. See Concurrent 

Programmer.
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ground bounce A phenomenon that limits the testability of high-speed PLDs on 
some device programmers. The term refers to the voltage on the 
ground terminal of the PLD’s die rising and falling when many 
outputs switch simultaneously. This voltage can induce extraneous 
clock signals that will make a device fail a functional test or reduce 
programming yield.

hex file A human-readable ASCII file that represents any binary data. Each 
byte in the binary pattern is represented by two hex characters (0-9, 
A-F) so that any of the 256 possible bytes, which include both 
control and unprintable characters, may be printed. The hex file may 
also contain address or checksum information. The pattern 
represented by the hex file may be represented by a binary file or any 
of the hex file formats – any file format may contain any pattern. 

I/O Input / Output.

JEDEC Joint Electron Device Engineering Council (pronounced JED'eck). 
A group organized by the IEEE (Institute of Electrical and 
Electronics Engineers) that has defined a standard file format for 
PLDs.

JEDEC file A file conforming to a standard format that specifies the 
configuration and testing procedure for a PLD. The file is in a 
human-readable ASCII format and consists of fields that start with a 
letter and end with an asterisk. Fields specify the pattern to program 
into the part, whether to secure the device, a set of test vectors to 
perform a functional test, and checksums to verify the integrity of 
the file.

LCC Leadless Chip Carrier. A square ceramic package that has no leads; 
instead it has metal areas that are surface-mount soldered to the 
target circuit. This package is usually used only for military and 
aerospace applications. Available up to 84 pins.

oscillator A device that produces an alternating output current.
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OTP One-time programmable. The characteristic of a memory device 
that can be programmed once but cannot be erased. When an 
EPROM is described as OTP, this means that its die is erasable 
when exposed to ultraviolet light, but because of its package, which 
is not transparent, it cannot be exposed to light and thus it cannot be 
erased.

package The plastic or ceramic that protects an IC die and connects it to the 
target circuit.

parallel printer port A standard port on virtually every PC designed for connection to a 
printer. This port has eight data lines and several control lines. 
Parallel ports may be either unidirectional or bi-directional. If your 
computer has a unidirectional port, the programmer will use the 
status lines to read data back from the programmer. The port allows 
high-speed communication (many times faster than a serial port). 
There may be up to three parallel ports in most PCs designated 
LPT1, LPT2, and LPT3.

PGA Pin Grid Array. A square, through-hold IC package that has pins 
located on a square grid with 0.1000-inch pitch. It may have up to 
several hundred pins. Used primarily for military and prototype 
designs.

PLCC Plastic Leaded Chip Carrier. A square plastic package that has J-
shaped leads on four sides. This can be surface mounted or placed in 
a socket for through-hole use. Available in 20 to 84 pins.

PLD compiler A software package that allows an engineer to specify the 
functionality of a PLD through a high-level language or schematic 
diagram. The software will convert the design into a JEDEC or 
other file for the PLD programmer. PLD compilers are available 
from numerous IC manufacturers and from third parties. The 
packages from IC manufacturers support only one brand of device 
and may be free, inexpensive or expensive. 

pneumatic Of or pertaining to air, gases or wind.

PQFP Plastic Quad Flat Pack. See QFP.

QFP Quad Flat Pack. A square IC package that has surface-mount leads 
coming from four sides. It is used for high-density applications, 
usually over 100 pins. Lead pitch may be 0.025 inches or smaller.
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socket module An interchangeable metal chassis that contains a programming 
socket.

TQFP Thin Quad Flat Pack. Similar to QFP but with a lower profile and 
physically smaller in length and width.
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